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Abstra t

Wellington

We present an overview of the basi fun tionality of
1.0, the
rst publi release of the des ription logi s based knowledge representation
and reasoning system developed by the Group of Logi and Computation at
King's College London. This paper also provides information on how to obtain
the software and in ludes a very brief introdu tion to the eld of des ription
logi s itself.
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Introdu tion

Wellington is a des ription logi s based knowledge representation system that

is urrently being developed by the Group of Logi and Computation at King's
College London. Version 1.0, introdu ed in [3℄, essentially implements an ABox
reasoner for the standard des ription logi ALC . The software is available from the
Wellington web site:
http://www.d s.k l.a .uk/resear h/groups/logi /wellington/

At the time of writing, this site provides a ess to Wellington 1.0 and gives
a short overview of des ription logi s related resear h in our group.
Wellington 1.0 is freely available over the Internet. It has been implemented
in Java and an be run either as an applet through a web browser or as a Java
appli ation. Se tion 2 tells you how. In Se tion 3 we review the basi notions of
des ription logi s as far as they are relevant for the fun tionality urrently available
in Wellington. This in ludes a de nition of the des ription logi ALC . How
formulas in this language are represented in Wellington is explained in Se tion 4.
Se tion 5 presents the graphi al user interfa e of the software and brie y des ribes
every fun tion that may be exe uted by the user. This in ludes in parti ular the
des ription logi al reasoning servi es provided by Wellington. We on lude with
some remarks regarding the implementation of the urrent system.
Te hni al Report TR-01-01, Department of Computer S ien e, King's College London, Mar h 2001.
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Getting and Running Wellington

The program may be run as an applet dire tly from our web site (provided your
browser an handle Java 1.2 applets). However, in order to be able to use the
system's full fun tionality (in parti ular loading and writing les) the Java ar hive
wellington.jar should be downloaded and Wellington should be run as an
appli ation. Like this:
java - lasspath wellington.jar
uk.a .k l.d s.wellington.gui.MainAppli ation

If you are familiar with Java, you may prefer to add wellington.jar to your
system's lasspath in the rst pla e.
The next session overs some theoreti al ba kground on des ription logi s. Se tions 4 and 5 des ribe the syntax of formulas Wellington an pro ess and explain
the various fun tions a essible through the graphi al user interfa e.
3

Des ription Logi s

Des ription logi s are formal knowledge representation languages with a relatively
simple syntax and well-de ned semanti s. A ording to the des ription logi
paradigm, knowledge is divided into a terminologi al part (TBox), where on epts
like \movies that are omedies and have no a tors who are famous" and relations
holding between su h on epts are de ned, and an assertional part (ABox), where
individuals are related to ea h other and asserted as being instan es of ertain onepts.
The entral notion of des ription logi s is that of a on ept. Con epts are sets
of obje ts (often alled individuals ). Some of the on ept-building operators, like
for example onjun tion, dire tly orrespond to standard set operators (like interse tion). On top of that, ALC o ers two kinds of quanti ation operations. In
des ription logi s, quanti ation is restri ted to obje ts that are related to some
referen e obje t via a given binary relation. These relations are alled roles. For
example, the on ept 8 denotes the set of obje ts for whi h every obje t ,
that is related to via the role , belongs to the on ept .
Given a set of on ept names and a set of role names the set of valid on ept
formulas of ALC may be de ned indu tively. Any on ept name is also a on ept
formula. Let and be on ept formulas and let be a role name. Then also
: (negation), u ( onjun tion), t (disjun tion), 8 (value restri tion),
and 9 (existential restri tion) are valid on ept formulas. So are > (\top") and
? (\bottom"). We may assign a on ept formula the status of a terminologi al
axiom to express that we want every individual to belong to that on ept. A set of
terminologi al axioms is alled a TBox. Here's an example for a on ept formula:
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Figure 1: Syntax and Semanti s of ALC Con epts
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The operations of impli ation and equivalen e an be de ned in terms of disjun tion and negation in the usual way. We have )  : t and
,  ( ) ) u ( ) ).
The semanti s of a on ept formula are de ned in terms of a domain  and
an interpretation fun tion I . Every on ept name is interpreted as a subset of
. Every role name is interpreted as a subset of   , the set of pairs over the
domain. The interpretation of omplex on ept formulas is de ned in Figure 1. An
interpretation is a model for a terminologi al axiom i it satis es I = . The
model of a TBox is an interpretation that is a model for every formula in that TBox.
In the ontext of knowledge representation appli ations, terminologi al axioms
are often restri ted to formulas of the form v_ (short for : t ) and =_
(short for (: t ) u ( t: )), where is a on ept name. Formulas of the latter
kind are alled on ept de nitions; those of the former kind are ommonly referred
to as primitive on ept de nitions. Observe that ( v_ )I =  i I  I and
( =_ )I =  i I = I . That is, from a purely logi al perspe tive v_ is nothing
but an impli ation and =_ oin ides with ,.
To express assertional knowledge we introdu e a set of individual names. Let
and be names of individuals, let be a role name, and let be a on ept
formula. We distinguish two kinds of assertions. A relational assertion is of the
form ( ) : and asserts and as being related via the role . An instantiational
assertion : asserts as belonging to . A set of assertions is alled an ABox.
An ABox together with a TBox is alled a knowledge base.
The interpretation fun tion I maps individuals to elements of the domain . A
relational assertion ( ) : is satis ed by an interpretation i ( I I ) 2 I and an
instantiational assertion : is satis ed i I 2 I . An interpretation is alled
a model for an ABox, if it satis es all the assertions in that ABox. It is alled a
model for an ABox with respe t to a TBox, if it is a model for both of them.
Typi al reasoning servi es in lude on ept subsumption, on ept onsisten y,
ABox onsisten y, and instan e he king. The former two only on ern the terminologi al part of a des ription logi al system. A on ept is said to be subsumed
by another on ept i I  I holds for every interpretation. We also speak
about subsumption with respe t to a TBox, namely whenever that subset-relation
holds for all models of a TBox. We may lassify a TBox by omputing the subsumption relation for every pair of atomi on epts mentioned in that TBox. A on ept
formula is onsistent (with respe t to to a TBox) i there is an interpretation (a
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model of the TBox) for whi h I is not the empty set. An ABox is onsistent (with
respe t to a TBox) i it has a model (with respe t to that TBox). An individual
is an instan e of a on ept (with respe t to a TBox) i for every interpretation
(every model of that TBox) I is in the set I . Observe that all these inferen e
servi es an be redu ed to ABox onsisten y he king (possibly with respe t to a
TBox). A on ept is onsistent i the ABox f : g (for some individual name
) is onsistent. Furthermore, is subsumed by i the ABox f : u : g is
in onsistent. Finally, we an infer that needs to be an instan e of i adding
: : to the ABox renders it in onsistent.
Reasoning with respe t to a TBox is onsiderably more omplex than pure ABox
reasoning. If formulas in the TBox are all of the form v_ or =_ , where is a
on ept name, and if these de nitions are a y li , we may repla e every o urren e of
su h a de ned on ept in the ABox with the respe tive on ept formula through
a pro ess known as unfolding and make the TBox obsolete. In the general ase,
however, this might not be possible.
For further information on des ription logi s we refer to [1℄ for a very readable
introdu tion to the eld, whi h in ludes an extensive bibliography. The next se tion
do uments how formulas in ALC are represented in the Wellington system.
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Syntax of the Input Language

In this se tion we de ne the syntax of the input language for ALC formulas used in
omplies to the quasi-standard set by the des ription
logi knowledge representation system spe i ation from the KRSS group of the
ARPA knowledge sharing e ort in 1993 [7℄.
In the future, we plan to extend Wellington's reasoning engine to over a
des ription logi enri hed with arithmeti al onstraints over role llers and a number
of other non-standard features. Su h a logi has rst been introdu ed in [6℄ and [5℄.
Wellington 1.0 an already be used to manage knowledge bases in that language,
but implementations of the reasoning servi es have not yet been in luded in the
urrent release. Therefore, the following spe i ation is restri ted to the syntax of
formulas in ALC.

Wellington. This language

4.1

Con ept Formulas

We start by des ribing the grammar of on ept formulas in Ba kus-Naur-form
(BNF). Expressions starting with a apital letter are non-terminals. Lower ase
expressions are terminals, i.e. these are typed into the system as they appear here.
With STRING we mean arbitrary alphanumeri strings (plus unders ore and hyphen -) that start with a letter.
Note that in BNF a bar | denotes a hoi e. A Con eptFormula, for example,
ould be either a PropositionalAtom, or a Con eptNegation, or et . A plus +
after an expression denotes a non-empty list of expressions of the kind des ribed.

4 Syntax of the Input Language
Con eptFormula

5

::= PropositionalAtom |
Con eptNegation |
Con eptConjun tion |
Con eptDisjun tion |
Con eptImpli ation |
Con eptEquivalen e |
QuantifiedFormula |
(Con eptFormula)

PropositionalAtom ::= Con eptName |
top |
bottom
Con eptName

::= STRING

Con eptNegation

::= (not Con eptFormula)

Con eptConjun tion ::= (and Con eptFormula+)
Con eptDisjun tion ::= (or Con eptFormula+)
Con eptImpli ation ::= (implies Con eptFormula Con eptFormula)
Con eptEquivalen e ::= (equivalent Con eptFormula Con eptFormula)
QuantifiedFormula ::= (all Role Con eptFormula) |
(some Role Con eptFormula)
Role

::= STRING

Consider, for example, the following on ept expression des ribing the set of all
movies that aren't omedies and that have an a tor who is of the \hero type":
Movie

u :Comedy u 9hasA tor HeroType
:

In Wellington syntax, this formula would be written as follows:
(and Movie (not Comedy) (some hasA tor HeroType))

In this example a few additional pairs of parentheses won't matter. This is
be ause of the last line in the de nition of Con eptFormula.
The atom top (or >) denotes the universal on ept to whi h every obje t belongs
and whi h is a super on ept to any given on ept formula. Analogously, bottom (or
?) stands for the in onsistent (or empty) on ept to whi h no obje t belongs and
whi h is a sub on epts to any given on ept formula.

6

Wellington 1.0 User Manual

As pointed out in the se tion on des ription logi s, a on ept impli ation like
of the Wellington philosophy not to assign on ept de nitions any highlighted
status. Moreover, on ept names need not be de ned as su h; they an simply
be used within formulas. To omply with the syntax of other systems, however,
a number of synonymous keywords have been de ned. For example, you may use
define- on ept instead of equivalent, or define-primitive- on ept instead of
implies.

C

) is logi ally equivalent to the primitive on ept de nition v_ . It is part

4.2

D

C

D

ABox Formulas

The assertional part of a knowledge base is a list of ABox formulas. A major
omponent of those are the previously introdu ed on ept formulas. An ABox
formula is either of instantiational or of relational type. Here's the grammar in
BNF:
ABoxFormula

::= (instan e ABoxIndividual Con eptFormula) |
(related ABoxIndividual ABoxIndividual Role)

ABoxIndividual ::= STRING

As an example, onsider the following little ABox, whi h ontains two assertions,
an instantiational and a relational one:
juliaRoberts : A tress u Famous
(juliaRoberts,prettyWoman ) : a tsIn
Here, juliaRoberts and prettyWoman are ABox individuals, A tress u Famous
is a on ept formula, and a tsIn is a role. In Wellington we would en ode this
as follows:
(instan e juliaRoberts (and A tress Famous))
(related juliaRoberts prettyWoman a tsIn)

We use the same kind of strings for on ept names, roles, and ABox individuals.
Only by the stru ture of the formulas submitted to the system Wellington is able
to determine what ategory a given term belongs to. In parti ular, you ould use
the same string, say julia, to denote an individual, a role, and a on ept name
within the same knowledge base.
4.3

Pattern Mat hing

Wellington is equipped with a simple sear h fun tion to nd formulas of interest
in a large knowledge base. You may sear h for spe i formulas or you may sear h
for groups of formulas at a time by providing a pattern des ribing the kind of
formulas you are interested in. Wellington's pattern mat hing me hanism has

5 User Interfa e and Reasoning Servi es
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been inspired by the anonymous variable onstru t used in the Prolog programming
language. The unders ore may represent any synta ti ally valid subformula of a
TBox or an ABox formula (this in ludes role and individual names).
For example, in order to nd all instantiational assertions about the individual
juliaRoberts that are present in the urrent knowledge base we ould sear h for
the following pattern:
(instan e juliaRoberts

)

As another example, suppose we were interested (for one reason or the other)
in all on ept formulas in the TBox that are impli ations whose onsequent is an
existentially quanti ed on ept with an unspe i ed role referring to the on ept
VeryLarge. The orresponding pattern would be:
(implies

(some

VeryLarge))

The delete fun tion uses the same pattern mat hing me hanism. For the above
example all formulas mat hing the query would be deleted from the urrent knowledge base.
5

User Interfa e and Reasoning Servi es

The Wellington interfa e onsists of a (small) text eld for user input (des ription
logi al formulas and patterns), a larger text area on whi h Wellington will print
any output, four buttons, and a number of menus. This is shown in Figure 2. Some
of the menu options will also laun h some very simple data input dialogues.
We separate the des ription of ea h menu option and push button into issues
relating to the management of knowledge bases (mainly buttons, File, and Show
menu) and reasoning servi es (Reasoning and Options menu), respe tively.
5.1

Managing Knowledge Bases

Choose the Open le option to open a le ontaining a list of TBox
and ABox formulas spe i ed in Ohlba h's des ription logi with arithmeti al onstraints [5℄ (whi h in ludes ALC ). The ontents will be parsed automati ally and
added to the urrent knowledge base. If there are any syntax errors the rst error
is reported to the user and no hanges are made to the urrent knowledge base.
The knowledge base urrently in memory an be written to a le by sele ting
the Save KB as option. Reset will lear the entire knowledge base. The File menu
is also used to exit Wellington.

File menu.

The Show menu an be used to view the urrently loaded ABox or
TBox, respe tively. The TBox is separated into on ept formulas and role axioms.
Please note that there are no role axioms in standard ALC.
Show menu.
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Figure 2: The Wellington Interfa e
To add a single ABox or TBox
formula, type it into the input text eld and press the Add button. Syntax errors
will be reported where appli able. To sear h for a formula or a pattern in the
urrent knowledge base, type it into the input eld and press Sear h. Pressing the
Delete button will delete all formulas from the urrent knowledge base that mat h
the pattern given in the input eld.

Adding, sear hing, and deleting formulas.

5.2

Reasoning Servi es

Choosing the ABox onsisten y option will he k the urrent
ABox for onsisten y. Note that reasoning with respe t to a TBox has not yet
been implemented, so TBox formulas in the knowledge base will simply be ignored.
Both the Con ept onsisten y and the Con ept subsumption options will result in
a dialogue window being laun hed to put in the on ept formula(s) in question.
Please re all that these two reasoning servi es are independent of the urrently
de ned knowledge base.
So far, reasoning is restri ted to ABoxes and on ept formulas in ALC. If any
of the formulas involved are not in ALC , an error message will be issued.
Re all that you an perform an instan e he k for an individual and a on ept

Reasoning menu.

a
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formula (with respe t to the urrently de ned ABox) by adding : : to the
knowledge base and he king the resulting ABox for in onsisten y.
C

a

C

At this stage there's just one option available. You may hange
the timeout value, that is the time (in millise onds) after whi h any inferen e pro ess
should be interrupted.

Options menu.

5.3

Other Items

The Edit menu provides ut and paste fa ilities. Pushing the Clear button will
lear the input text eld. Use the Edit menu to lear the output text area. The
Help fun tion has not been implemented yet.
6

Con lusion

We have presented the des ription logi s based knowledge representation system
urrently implements a Tableaux-like al ulus to he k the onsisten y of the assertional omponent of a knowledge base spe i ed in ALC . Other
reasoning servi es are based on this ore algorithm. It in orporates a number of wellknown optimisation te hniques, in luding lexi al normalisation, semanti bran hing
with heuristi guided sear h, beta simpli ation, boolean onstraint propagation,
and ba kjumping. We refer to [2℄ for a re ent survey paper on Tableaux for des ription logi s and to [4℄ for a good overview of optimisation te hniques for these
al uli.

Wellington. It
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